3 GENESYS

This PDF is generated from authoritative online content, and
is provided for convenience only. This PDF cannot be used
for legal purposes. For authoritative understanding of what
is and is not supported, always use the online content. To
copy code samples, always use the online content.

GVP Troubleshooting Guide

Genesys Voice Platform 85

12/29/2021



www.princexml.com
Prince - Non-commercial License
This document was created with Prince, a great way of getting web content onto paper.


Table of Contents

GVP Troubleshooting Guide
Troubleshooting methodology
Basic Troubleshooting
Collecting Log Files
Exporting Configuration Options
Collecting Logs
Collecting Data
Checking Disk Space
Collecting Dump Files
Locating Installation Package Versions
Collecting Packet Traces
Running test VoiceXML and debugging VoiceXML applications
Debugging CTI Connector and ICM Client
Debugging T-Server-CUCM to Media Server Connector
Debugging Dialogic
Troubleshooting with Composer
HTTP 503 Error
No TTS Resource
No ASR Resource
Debug Call Failed
Stale Application Pages
CTIC Application Errors
How to View SNMP MIBs
Troubleshooting Tools
Frequently Asked Questions
Media Control Platform
Reporting Server
Resource Manager
Cluster Mode Connection Failure
T-Server-CUCM to Media Server Connector
Troubleshooting Fetch Issues

oo N U1 W

10
11
12
15
16
18
20
22
23
26
27
31
32
33
34
35
37
38
39
41
44
45
49
54
56
59
60



GVP Troubleshooting Guide

GVP Troubleshooting Guide

Welcome to the Genesys Voice Platform 8.1 Troubleshooting Guide. This document provides
information about Simple Network Management Protocol (SNMP) traps, as well as basic
troubleshooting information for the Genesys Voice Platform (GVP).

The section Troubleshooting options in this document includes information from
version 8.5 of GVP. Otherwise, this document is valid only for the 8.1 release(s) of this
product.

About GVP

GVP is a group of software components that constitute a robust, carrier-grade voice processing
platform. GVP unifies voice and web technologies to provide a complete solution for customer self-
service or assisted service. In the Voice Platform Solution (VPS), GVP 8.1 is fully integrated with the
Genesys Management Framework.

GVP uses the Genesys Administrator, the standard Genesys configuration and management graphical
user interface (GUI), to configure, tune, activate, and manage GVP processes and GVP voice and call
control applications. GVP interacts with other Genesys components, and it can be deployed in
conjunction with other solutions, such as Enterprise Routing Solution (ERS), Network Routing Solution
(NRS), and Network-based Contact Solution (NbCS).

Intended audience

This document is primarily intended for system administrators, technical support, partners, and
customers who are deploying and troubleshooting small, medium, or large single-tenant Genesys
Voice Platform (GVP) environments.

This document assumes that you have moderate experience with GVP, either by having attended a
Genesys University course, or having worked with Genesys Professional Services on the GVP system.

This document also assumes that you have a basic understanding of these topics:

* Computer-telephony integration (CTI) concepts, processes, terminology, and applications
* Network design and operation
e Your own network configurations

¢ GVP basic operations
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* SNMP traps

You should also be familiar with Genesys Framework architecture and functions.

GVP Troubleshooting Guide
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Troubleshooting methodology

When troubleshooting an issue with your Genesys Voice Platform (GVP) solution, it is important to
take a methodical approach in order to quickly identify and resolve the cause of the issue. Drawing
conclusions too quickly and making undocumented changes to the system(s) can result in making the
issue worse.

This topic outlines a brief methodology that you can follow in order to troubleshoot issues that you
might encounter with your GVP solution.

Describing the Problem

The first and most important step in troubleshooting any issue is to clearly define the problem. Your
problem description should be as detailed as possible and include the following information:
e A clear indication of your system’s symptoms

¢ How you discovered the issue. For example, did you receive an alarm from the system? Did a caller
identify the issue(s)?

¢ When did the symptom first start to occur?

¢ Was GVP previously running without issues, and the problem recently started to occur? If yes, what
changes did you make to the system? For example, did you deploy a new VoiceXML application or make
some configuration changes?

¢ How often does the symptom occur? For example, does it occur on every call or intermittently?

e Can you isolate the symptom to a particular site, system, voice application, or other component?

Gathering Relevant Information

Once you have a clear description of the issue, you can start to gather relevant information to isolate
and identify the cause of the issue. This might include the following information:

¢ Recent changes that you have made to the system or environment. These can include operating system
updates or patches, system or network configuration changes, or voice application changes.

¢ A more detailed description of the symptom. If callers are experiencing the symptom, can more specific
information be gathered? For example, callers might report that their calls were dropped. In this case, it
would be useful to know which voice application they were calling, where in the voice application they
were dropped, and where they were calling from.

¢ Steps to reproduce the issue. If the symptom is reproducible, what are the detailed steps you can follow
to make it occur?

* Whether the symptom can be isolated to a particular site, system, or voice application. If it can, you
should review the particulars of that site, system, or voice application and compare them to that of
ones that are not experiencing the issue.
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* You may need to capture various log files for later analysis.
¢ Network traffic capture (via Wireshark or some other tool).

* You may need to export the configuration of the system.

See Basic troubleshooting for information on how to collect log files, capture network
traffic, and export the system configuration.

Creating an Action Plan

You can now create an action plan to further isolate the issue based on the information you have
gathered. Document the steps you are going to follow, and then check them off as you complete
them.

Keep a record of any changes you make to the system as you go, as well as any observations you
make. It is very difficult to remember what you did after the fact, and this information might be
critical in preventing future issues.

Implement any changes one at a time, because you may not know which change corrected the issue
if more than one change is implemented at a time.

Verifying the Resolution

Once you have taken measures to correct the problem, you must properly test the system to ensure
that the symptoms are no longer occurring.

Document what you expect to happen, and then compare your expectations with your written
observations of the system during your tests.

If the symptoms continue to occur, restart this process from the initial problem description.

Describe what is occurring now as it may not be the same as the initial problem, especially if you
have made changes.

GVP Troubleshooting Guide 6
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Basic Troubleshooting

This topic provides basic troubleshooting information for Genesys Voice Platform (GVP). It contains
the following sections:

* Collecting log files

¢ Exporting configuration options

* Collecting logs

¢ Collecting data

¢ Checking disk space

* Collecting dump files

¢ Locating installation package versions

¢ Collecting packet traces

* Running test VoiceXML and debugging VoiceXMLApplications

¢ Debugging CTIl Connector and ICM Client

e Debugging T-Server-CUCM to Media Server Connector

* Debugging dialogic

GVP Troubleshooting Guide
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Collecting Log Files

Collecting Log Files

Genesys recommends that you check and collect the logs when you are troubleshooting an issue.

When a GVP process shuts down unexpectedly, check the snapshot file instead of the
log file for the reason for the crash. The snapshot file contains the last/latest log
information, so it might have logs that are more recent than the regular log file. The
snapshot file is circular; you should check it for the latest time stamp.

The following table provides the default location and name of log files for the GVP components.

GVP Component

Media Control Platform (MCP)

Media Resource Control Protocol
Proxy (MRCPP)

Call Control Platform (CCP)

Resource Manager (RM)

Policy Server (PS)

Fetching Module (FM)

Note: The FM functionality is
part of MCP as of GVP version
8.1.2.

CTI Connector (CTIC)

Third-Party Squid (Optional)
Note: Squid is an open
sourceproduct.

Location

Windows: <MCP Installation
Dir>\1logs\

Linux: opt/genesys/
gvp/<MCP>/1logs

Windows:<MRCPP
InstallationDir>\logs\
Linux: /opt/genesys/
gvp/<MRCPP>/10gs

Windows:<CCP
InstallationDir>\1logs\
Linux:/opt/genesys/
gvp/<CCP>/1logs

Windows:<RM Installation
Dir>\1logs\
Linux:/opt/genesys/
gvp/<RM>/logs

Windows: <PS Installation
Dir>\1logs\

Linux: /opt/genesys/
gvp/<PS>/1logs/

Windows:<FM Installation
Dir>\1logs\
Linux:/opt/genesys/
gvp/<FM>/logs

Windows:<CTIC Installation
Dir>\Logs\

Note: In 8.1.4 and later, the CTIC
is supported on Windows and
Linux.

Windows:C:\squid\var\
logs\Linux:/var/log/squid/

Default Log File

mcp.<timestamp>.log

MRCPProxy.<timestamp>.log

ccp.<timestamp>.log

ResourceMgr.<timestamp>.log

ps.log

fm.<timestamp>. log

CTIConnector.<timestamp>.log

access. log
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Windows:<RS Installation
Dir>\1logs
Linux:/opt/genesys/
gvp/<RS>/1logs

Windows:<SSG Installation
Supplementary Services Gateway Dir>\1logs\
(SSG) Linux:/opt/genesys/
gvp/<SSG>/1logs

Windows:<PSTNC
InstallationDir>\1logs\
Linux:/opt/genesys/
gvp/<PSTNC>/1logs

Windows:<UCMC Installation
T-Server-CUCM to Media Server Dir>\Logs
Connector Linux:/opt/genesys/
gvp/<UCMC>/Logs

Reporting Server (RS) rs.log

SSG.<timestamp>.log

PSTN Connector PSTNConnector.<timestamp>.1log

UCMConnector.<timestamp>.Log

The directory for logs can be changed from the default shown. A common practice is
to create a folder named Logs and set it as the log location for each component
(under Options > Log for that application). Name the log appropriately; for example,
RM_Debug.log. This practice reduces the navigation through the OS when
troubleshooting multiple components.
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Exporting Configuration Options

Exporting configuration options and providing this information to Genesys Technical Support enables
them to see how your platform is configured. You can export configuration options for any application
from Genesys Administrator. For information on how to do so, see the Framework 8.1 Genesys
Administrator Help.

You can also export IVR Profiles in the same manner, and you can export DN mapping data by
exporting options of the Tenant object.

Another way to obtain configuration options is the local .ini file that GVP creates, which contains all of
the configuration information read from Framework during startup. The .ini file is found in the <IP
installation>\config directory. The file name is <application name>.ini (for example,

MCP jade DITLoad.ini), and the <application name> is the name of the application as configured in
Framework.

GVP Troubleshooting Guide 10
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Collecting Logs

Windows Event Viewer

You can access the Windows Event Viewer from Control Panel > Administrative Tools. Some GVP
components use the Event Viewer to log application event messages, which can then be accessed by
clicking on the application file in the left pane of the Event Viewer GUI. The source of each Event
Viewer message is the name of the executable program that is associated with the process that logs
the event message.

Processes such as the pwcallmgr.exe, pwproxy.exe, resourcemanager.exe, ccpccxml.exe,
CTIConnector.exe, and ssg.exe use the Event Viewer to indicate problems that might occur during
startup, before normal logging is available.

In addition, the logging infrastructure used by pwcallmgr, resourcemanager, and ccpccxml might
also use the Event Viewer to display special events that are related to GVP logging.

In the Event Viewer GUI, you can modify properties for the application file by clicking the application
file > Action menu > Properties. The maximum log file size and filtering options are available
through this Properties window. The location of the event file is also displayed.

For this release of GVP, only the Information event type is used by the GVP components.

RH syslog

The default system log file on RHEL is /var/log/messages. You must have root privilege to read this
file.

GVP Troubleshooting Guide 11
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Collecting Data

Windows

This section describes the PerfMon counters, which enables you to check CPU and memory use. The
PerfMon counters are detailed below:

* Process counters (pwcallmgr.exe, ccpccxml.exe, ssg.exe, java.exe, resourcemgr.exe,
CTIConnector.exe):
* % Processor Time
* Working Set
* Private Bytes
* Handle Count
e Thread Count
* Virtual Bytes
e Memory counters:
e Available Kilobytes
e Committed Bytes
* Processor counters:

* % Processor Time (choose _Total from Select Instances From List)

LogicalDisk Counters (choose _Total from Select Instances From list)
* Avg Disk Bytes/Read
e Avg Disk Bytes/Write
* Avg Disk Queue Length

e CPU time for the executable program. (This is a column in the Task Manager.)

Make sure the PerfMon data is written as a .csv file, not binary. The collection interval should be 15
seconds.

Linux

You can use the following commands to collect data:

¢ top—to monitor CPU and memory usage per process, and to monitor high level system CPU and
memory usage (installed with Linux: procps-3.2.3-8.9.1386. rpm on RHEL)
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Collecting Data

¢ sar—to monitor detail system resource usage (installed with Linux:
sysstat-5.0.5-16.rhel4.1386.rpm on RHEL)

e gvpfd—to monitor per process file descriptor usage

gvpfd source
$owner = "all";
$duration = shift;
$repeat = shift;

$logfile = shift;

$pattern = "/usr/local/phoneweb/logs/logProcess.txt";
sub trim($)

{

my $string = shift;
$string =~ s/"\s+//;
$string =~ s/\s+$//;
return $string;

}
sub tabify($)
{

my $string = shift;
$string =~ s/\s+//9;
return $string;

print "Starting vgfd\n”;
print "Process Owner: $owner \n”;
print "Interval: $duration seconds \n";
print "Repeat by: $repeat times \n”;
print "Log file: $logfile \n”;
open (LOGFILE, ">$logfile");
print LOGFILE
"TIME\tNumFD\tPID\ tUSER\tPR\tNI\tCPU\tTIME+\tMEM\tVIRT\ tRES\tSHR\ tS\ tCOMMAND
for ($i=0; $i<$repeat; $i++){
$ts = ‘date +"%D %T"‘; chop($ts);
my @list;
if ($owner eq "all"){
@list="'ps -A | grep -v PID | grep -f $pattern’;
}else{
@list="ps -u$owner | grep -v PID | grep -f $pattern’;

$index=0;
while ($list[$index]){
$list[$index]=trim($list[$index]);
@token = split(/\s+/,$list[$index]);
$pid = $token[0];
$pname = $token[3];
$numFD = ‘find /proc/$pid/fd -not -type d | wc -1'; $numFD=trim($numFD);
$top = ‘“top n 1 b | grep $pid | grep $pname’; $top=tabify(trim($top));
print LOGFILE "$ts\t$numFD\t$top\n”;
$index++;

sleep $duration;

}
close (LOGFILE);
exit 0;

To initiate all three process, you can use the following script:
gvpmon source

echo "Starting gvpmon script"
N=$1

GVP Troubleshooting Guide

13



Basic Troubleshooting Collecting Data

(( D=1+$2/$N))

rm -f ~pw/logs/sar.dat

nohup /usr/lib/sa/sadc $N $D /var/log/sar.dat >/dev/null &
nohup /usr/bin/top -d $N -n $D -b > /var/log/top.log &
nohup ./vgfd $N $D /var/log/fd.log >/dev/null &

It takes two arguments:

e arg l—interval between each snapshot captured in seconds
e arg 2—number of snapshot to capture
The preceding scripts/programs require a super user privilege to execute. After creating the two

preceding scripts, make sure that you add executable permission on them prior to running, by
issuing: chmod a+x {script’s filename}

GVP Troubleshooting Guide
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Checking Disk Space

Windows

Go to My Computer and take note of the free space under the C drive.

Linux

Use the df -k command or the du . command to check for disk space usage and availability.
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Collecting Dump Files

Collecting Dump Files

This topic describes looking for and collecting dump files for analysis.

Procedure: Collecting dump files

Purpose: To collect dump files in Windows in the event of an unexpected exit of any of the
components without any .dmp files generated.

Start of procedure

1. Log into the console of the machine.
You should see an error dialog box from Microsoft that states an error has occurred and asks
whether you want to report it to Microsoft for the pwcallmgr.exe.

2. Click the option to view additional information, and click what will be sent to Microsoft.

The location of an mdmp file and an hdmp file should be listed.

3. Back up these two files and send them to Genesys Technical Support.

End of procedure

Location of Core and Dump Files

The following table lists the location of core/dump files for each component.

Component

Media Control Platform

MRCP Proxy

Call Control Platform

Resource Manager

Fetching Module

Operating system

Windows
Linux

Windows
Linux

Windows
Linux

Windows
Linux

Windows

File path

<MCP Installation Dir>\logs\
pwcallmgr*.dmp file

<MCP Installation Dir>\bin\
core. * file

<MRCPP Installation
Dir>\logs\srmproxy*.dmp file
<MRCPP Installation
Dir>\bin\core.* file

<CCP Installation Dir>\bin\
ccpcexml* . dmp file

<CCP Installation Dir>\bin\
core.* file

<RM Installation Dir>\logs\
resourcemgr*.dmp file

<RM Installation Dir>\bin\
core. * file

<FM Installation Dir>\logs\

GVP Troubleshooting Guide

16



Basic Troubleshooting Collecting Dump Files

pwproxy*.dmp file
Linux <FM Installation Dir>\bin\
core.* file

<CTIC Installation
Dir>\logs\cticonnector*.dmp
file

<CTIC Installation Dir>\bin\
core.* file

<SSG Installation Dir>\logs\
Windows ssg*.dmp file
Linux <SSG Installation Dir>\bin\
core. * file

<PSTNC Installation
PSTN Connector Windows Dir>\logs\pstnconnector*.dmp
file
<UCMC Installation
Dir>\logs\ucmconnector*.dmp

Windows

CTIl Connector L1105

Supplementary Services Gateway

T-Server-CUCM to Media Server Windows

Connector Linux file . . .
<UCMC Installation Dir>\bin\
core.* file

The Reporting Server (RS) is a
Java-based product that does not

Reporting Server N/A produce dump files. Any errors
produced by the RS are written
to the log files under \logs.

The Policy Server (PS) is a Java-
based product that does not

Policy Server N/A produce dump files. Any errors
produced by the PS are written to
the log files under \logs.

The Fetching Module functionality is part of MCP as of version 8.1.2.

Configuring Windows Server 2008 to Generate Core Dump Files

A Windows Server 2008 R2 computer can generate core dump files when an application terminates
because of both assertion failures and segmentation faults.

To enable this functionality, you must configure the Windows Server 2008 R2 computer to create core
dump files using the registry.

To do so, see the following link:
http://msdn.microsoft.com/en-us/library/bb787181.aspx
In particular, the key LocalDumps does not initially exist; you must create it in the Registry.

Without that registry setting set, core dumps are not generated for both assertion failures and
segmentation faults.
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Locating Installation Package Versions

The GVP application log file will print the installation package version during process startup, or you
can locate the version using the following procedures.

Windows

1. To locate the installation package (IP) version of your GVP system, right-click the GVP executable
program:

e Media Control Platform—pwcallmgr.exe

* MRCP Proxy—srmproxy.exe

* Fetching Module (If installing GVP 8.1.0 or 8.1.1)—pwproxy.exe
* Resource Manager—resourcemgr.exe

e Call Control Platform—ccpccxml.exe

* CTI Connector—cticonnector.exe

* Supplementary Services Gateway—SSG. exe

* PSTN Connector—PSTNConnector.exe

e T-Server-CUCM to Media Server Connector—UCMConnector.exe

2. Go to the Properties > Version tab.

3. In the Other Version Information block, check the File Version value and report.

Linux
¢ Use the following command:
strings <GVP executable or .so> | grep '\$Id:' | grep 'Build:'’
Example:
* [pw@marsanne bin]$ strings pwcallmgr | grep '\$Id:' | grep 'Build:'

$Id: Media Control Platform: GVP 8.0 (Build: 8.1.001.10) $
@(#)$Id: GVP Common Lib: GVP Common Lib (Build: 8.1.001.01) $
[pw@marsanne bin]$ strings 1ibCMSIP2.so | grep '\$Id:' | grep
'Build:"

$Id: Media Control Platform: GVP 8.0 (Build: 8.1.001.10) $

GVP Troubleshooting Guide
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¢ You can also use the ident command:
ident <GVP executable or .so>
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Collecting Packet Traces

Windows

Wireshark is a network protocol analyzer that you can use for analyzing network problems. You can
download it from Wireshark.org. After installing wireshark on your Microsoft Windows machine, you
can perform the following actions.

Capturing Network Traffic

1. Open Wireshark.

2. To start capturing network traffic, go to Capture on the menu bar, and then click Interfaces. A window
will open.

3. Click Start on the desired network interface. Wireshark will start capturing network traffic.

4. To stop capturing, go to Capture on the menu bar, and click Stop.

5. To save the captured packets, go to File on the menu bar, and click Save As. A window will open.

6. Enter a file name, and then click Save to save the file.

The Packet Range option enables you to select a specific set of packets to save.

Creating a Packet Filter

Wireshark supports packet filters, which enables you to filter out unwanted packets. For example, the
sip || rtp filter will display only SIP and RTP packets. You can click Expression to see more filter
options.

Displaying VolIP Calls

Wireshark can look for VolIP calls from the captured packets. Go to Statistics on the menu bar and
click VolP Calls. A window will open with the list of VoIP calls.

Linux

1. Use the following command:
dumpcap -i <interface-name> -w <output file>.pcap
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If using RHELS5, use the following command:
tcpdump -s 1500 -i eth® -w /root/filename.pcap

2. Press Ctrl + C to stop and exit the capture.

3. You can then transfer the capture file to a Windows machine to view and filter it by using Wireshark
software.
For example—If eth0 is the active interface on the machine with which the GVP component (such
as MCP, CCP, or RM) is associated, the command in Linux would be the following:

dumpcap -i eth@ -w gvpcapture.pcap

GVP Troubleshooting Guide 21
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Running test VoiceXML and debugging
VoiceXML applications

Running test VoiceXML applications

The MCP component of GVP includes sample VoiceXML applications, which are located in the
following directory (for both Windows and Linux):

<MCP_Installation Dir>\samples\

By using these sample VoiceXML applications, you can make a test call directly to the MCP by using
the NETANN prompt and collect service (http://www.ietf.org/rfc/rfc4240.txt section 4) to troubleshoot
the status of the MCP.

For example, in Windows or in Linux, if the MCP is running at the default 5070 SIP port and the
installation directory is C:\ProgramFiles\GCTI\gvp\MCP\, you can dial the following to the
helloworld sample VoiceXML application from your softphone:

sip:dialog@<mcp host name>:5070;voicexml=file://C:\ProgramFiles\GCTI\gvp\MCP\samples\
helloworld.vxml

Debugging VoiceXML applications

Make use of the interaction level logs that are generated by the MCP. These logs provide details of
the call execution.

This only applies to GVP Next Generation Interpreter (NGI).

You can also use Composer for debugging applications.
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Debugging CTI Connector and ICM Client

To debug issues with CTI Connector (CTIC) and Cisco’s Intelligent Contact Management (ICM) Client,
you might not require full logs but specific logs, such as, SIP messages and GED-125 messages.

To obtain these logs, use the following log configuration option and value:
[ems]logconfig.MFSINK option value in the format *|*|*
Where:

e The first * (asterisk) represents the log level and the valid values are 0-5.

e The second * (asterisk) represents the module ID.

e The third * (asterisk) represents the Universal Logon ID (ULID).

CTI Connector modules

Three modules exist within the CTl Connector:

e CTIC Adaptor
¢ |VR Server Client
¢ Cisco ICM Client

To print logs that are associated with the CTIC Adaptor module; use a value of 171; For the ICM Client
module, use a value of 173 . Examples

1. To obtain GED-125 message flows only, use the following value:
*|173|1626,1637

2. To obtain SIP message flows only:
*|*|1280

3. To obtain both GED-125 and SIP message flows, use the following values, appending them with the |
(bar) symbol:
*|171,173]|1626,1637|*|*|1280

Reserved ULIDs

The following table contains the ULIDs that are reserved for the CTIC Adapter and ICM Client.

ULID Configuration Option Description
CTICAdapter

1554 CTICA CALLFLOW SIP
ICM Client
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All messages exchanged

1626 ICMC_MESSAGE_EXCHANGE INFO between CTIC & ICM.

Session-specific logs. For
1634 ICMC_CALL_INFO example, OPEN/CLOSE.
1637 ICMC SESSION INFO Call-specific logs.

Printing a Call Statistics Summary to a Log File

Print a Call Statistics Summary to a log file by using the following configuration: [CTIC]
LogMIBStatsInterval=180

Set this configuration option to -1 to disable this feature. The default value is 180. The minimum and
maximum values for this option are 30 and 1800, respectively. See the following sample Call Statistics
Summary:

Sample Call Statistics Summary:

Total Calls = 28

Total Calls Completed = 32

Total Calls Failed AtCTI = 4

Total Calls Failed AtGVPPlatform =
Total Active Calls = 0

Total Queued Calls =

Total Bridged Calls =

Total RouteResponses Received =
Total Default Agent Number Received =
Total NewCall Failed = 3

Total RouteRequest Failed =

Total SIP Calls/Legs = 52

Total SIP Calls/Legs Answered = 48
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Total SIP Calls/Legs Rejected = 4

Total SIP Calls/Legs Completed = 48
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Debugging T-Server-CUCM to Media Server
Connector

To debug issues with T-Server-CUCM to Media Server Connector, you might require specific logs, such
as the call tracing and the media operations related to call leg.

To obtain these logs, use the following log configuration option and value:
[ems]logconfig.MFSINK option value in the format *|*|*

Where:

e The first * (asterisk) represents the log level, and the valid values are 0-5.

e The second * (asterisk) represents the module ID.

e The third * (asterisk) represents the Universal Logon ID (ULID).
To print logs associated with the T-Server-CUCM to Media Server Connector module, use 244 for the
module ID. For example, to obtain the call establishment/teardown messages along with SIP message
exchange, use the following:
*|244|2441
To get media operations related information, use:
*|244|2442

To troubleshoot specific calls, enable both of them as follows:

*|244|2441,2442
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Debugging Dialogic

This topic describes the basic steps for troubleshooting Dialogic, TDM and PSTN Connector issues.

TDM Troubleshooting

This section describes how to troubleshoot a telephony TDM issue.

1. Check the back of the Dialogic board for any red or yellow LED lights which might point to a Dialogic or
Trunk issue.

2. Use the MIB Browser to:
1. Check the PSTN Connector MIB table (pSTNCBoardTable) for any alarms.

The D-Channel status will always show an error if you are not using ISDN.

2. Check the PSTN Connector MIB table (pSTNCPortTable) for out-of-service ports.

3. Check the PSTN Connector MIB table (pSTNCCallSummaryTable) for any abnormalities in the call
counters.

For more information on the MIB tables, see the Genesys Voice Platform 8.1 SNMP and MIB Reference
file.

You can also use the PSTN Connector Dashboard in Genesys Administrator to see the current status
of Dialog board. For more information, see the Genesys Voice Platform 8.1 User’s Guide.

Call Failure Troubleshooting

This section describes how to troubleshoot failed calls.

Busy Signal
There are two types of busy signal:

e Slow busy

e Fast busy
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Slow Busy
A slow busy signal indicates a failure to connect to the PSTN Connector. When this occurs:

1. Determine which PSTN Connector is receiving the call and check the voice circuits on that server.

2. Check the voice circuits on the server. If you do not see all of the D and B channels, restart the Dialogic
services. If the channels do not start, work with the carrier to determine if the problem is a circuit issue.

3. Refer the problem to the engineer in charge of provisioning phone numbers.

Fast Busy

A fast busy signal indicates a carrier failure; that is, the call is dropped somewhere in the Network
Service Provider (NSP) network. To solve this problem:
1. Duplicate the error.

2. Contact the NSP, and ask them to help troubleshoot the issue by tracing the call using the time of call,
the ANI, the number dialed, and the trunk which the call should be routed.

Dead Air

Dead air is the lack of dial tone or busy signal. It suggests that a call was delivered successfully to
the platform, but the call failed before connecting to the voice application.

If dead air is occurring, or a call returns dead air, make a test call and check for ALl Ports Busy
trap.

PSTN Connector-Specific Issues

An inbound call to PSTN Connector can fail in the following scenarios:

e The inbound port is down, and the call cannot be delivered to the platform.
e The PSTN Connector process is stopped, and it cannot accept calls.
* A portisin a disconnect state, so calls fail to be accepted on the port.

When one of these failures occurs, it can result in dead air or a busy signal. To determine the source
of this problem, make a test call and note whether or not the call is delivered to the PSTN Connector.

To solve these call failures:

1. Determine the PSTN Connector on which the calls should be landing.

2. If the failures are intermittent, isolate the servers on which the calls are failing. Make multiple calls, and
make note of the servers on which the calls are serviced correctly, and the servers on which they are
not received.

3. After you have isolated the server or servers that are not operating correctly, determine whether all the
ports on the server have the In Service status.

4. If a port displays the Qut Of Service status, reset the port. If the port does not come back into service,
stop and restart PSTN Connector gracefully; that is, so that it waits for all the active calls to complete. If
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the ports are still marked as Out Of Service, restart the server.
5. If a portisin a Disconnect state:
1. Stop the PSTN Connector gracefully. This will not enable the PSTN Connector to exit.
2. \(\tlhen all of the active calls have been completed, stop the PSTNConnector.exe process, and restart
it.
6. If the portis In Service, make a test call to the maintenance number of the port in question, and
determine whether the maintenance number is working.

7. If the maintenance number is working correctly, there may be a routing problem with the carrier for this
number. Contact the carrier for assistance.

8. If the maintenance number is not working, reset the port and test the maintenance number.

9. If the maintenance number is routing correctly, and the maintenance call is still not working, contact the
carrier for assistance.

A slow busy signal indicates a problem with the server. A fast busy signal indicates a
routing problem with the carrier.

PSTN Connector Restart

On the PSTN Connector, in certain scenarios, if there is an unexpected shutdown, it is possible that
the Dialogic firmware end up in an inconsistent state, which would affect subsequent calls.

To recover from this situation:

1. Use Genesys Administrator to shut down the PSTN Connector.
2. Use DCM to shut down the Dialogic services.

3. Use DCM to restart the Dialogic services.
4

. Use Genesys Administrator to start the PSTN Connector.

Dialogic Diagnostic Tools

Dialogic SR 6.0 includes several useful diagnostic tools. Most of the tools run only on the DM3 series
boards. All Dialogic tools are located in the \Dialogic\bin directory.

e PSTNDiag—A GUI tool used for checking board, trunk, and channel status.
e CASTrace—A command line tool used to trace CAS signaling bits.

e ISDNTrace—A command line tool used to trace the ISDN D-Channel.

For more information on the tools, see the following documents provided by Intel:
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 Intel Dialogic System Software for DM3 Architecture Products on Windows

e Dialogic Universal Hardware Diagnostics Guide

GVP Troubleshooting Guide 30



Troubleshooting with Composer Debugging Dialogic

Troubleshooting with Composer

You can troubleshoot voice application errors by using Composer. The errors that are described in this
chapter will appear in the call-trace view of Composer. When you start a call through Composer, a
window automatically appears that contains the call traces. You can then check the call traces to
obtain information about the Genesys Voice Platform (GVP) configuration and other issues.

All of the example logs that are shown in this topic are interaction level logs. Select
Windows->Show View->Call Trace to open the call trace window manually if
required.

This topic contains the following sections:

e HTTP 503 Error

* No TTS Resource

* No ASR Resource

¢ Debug Call Failed

e Stale Application Pages
* CTIC Application Errors
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HTTP 503 Error

Check the traces for an error that is similar to the following:
For DTMF Grammar:

event error.badfetch.http.503:1|HTTP error response 503 [Target: http://10.10.30.80/
vggrammarbase/inlinetmp/3-181105937.grxml]

event handler enter:error.badfetch|http://10.10.30.235:8080/Test05042008/src-gen/
Main.vxml log com.genesyslab.quality.failure:error.badfetch event terminated session
prompt prompt play audio|builtin:default audio/the requested page cannot be found.vox
fetch end Fail (HTTP error response 503):http://10.10.30.80/vggrammarbase/inlinetmp/
1-181105937.grxml fetch end Fail (HTTP error response 503):http://10.10.30.80/
vggrammarbase/inlinetmp/5-181105953.grxml prompt play audio|builtin:default audio/
goodbye.vox prompt end done event handler exit:error.badfetch

For Speech Grammar:

input _end ERROR|| ||| event error.badfetch:1|
event_handler_enter:error.badfetch|file:///c:/VoiceGenie/mp/samples/helloasr.vxml log
com.voicegenie.quality.failure:error.badfetch event terminated session prompt

prompt play audio|builtin:default audio/the requested page cannot be found.vox

The preceding errors indicate that something is incorrect with the IIS settings on the Media Control
Platform (MCP). Verify the following items:

e Verify that IIS is running.

¢ Verify that the vggrammarbase virtual directory is present and pointing to the
MCP_INSTALL PATH>\grammar\inlinetmp folder.

e Verify that the MIME type for vggrammarbase is configured properly.

GVP Troubleshooting Guide 32



Troubleshooting with Composer No TTS Resource

No TTS Resource

The following example indicates that one of these scenarios might be occurring:

1. The TTS server is down.

2. The TTS server is not configured for the MCP.
3
4

The license has expired for the TTS server.

. The TTS server is overloaded.

Example:

prompt play tts|<?xml version="1.0" encoding="UTF-8"?><speak version="1.0"
xmlns="http://www.w3.0rg/2001/10/synthesis" xml:lang="en-US">Welcome to the Composer
Voice User Input Demo Press one for input I D, two for message, three for input
grammar</speak> exec _error Could not play audio <?xml version="1.0"
encoding="UTF-8"7?><speak version="1.0" xmlns="http://www.w3.0rg/2001/10/synthesis"
xml:lang="en-US">Welcome to the Composer Voice User Input Demo Press one for input I
D, two for message, three for input grammar</speak> prompt end error input end
ERROR| [ | |
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No ASR Resource

The following example indicates that one of these scenarios might be occurring:

1. The ASR server is down.

2. The ASR server is not configured for the MCP.
3. The license has expired for the ASR server.
4

. The ASR server is overloaded.
Example:

prompt end asrbargein prompt play tts|<?xml version="1.0" encoding="UTF-8"?><speak
version="1.0" xmlns="http://www.w3.0rg/2001/10/synthesis" xml:lang="en-US">Welcome to
the Composer Voice User Input Demo Press one for input I D, two for message, three
for input grammar</speak> input end ERROR||||| asr_trace

ASR NORESOURCE:results:<Error> event error.noresource.asr:1|

event handler_enter:error.noresource.asr|http://10.10.30.235:8080/Test05042008/src-
gen/ Main.vxml log com.genesyslab.quality.failure:error.noresource.asr event
terminated session prompt prompt play audio|builtin:default audio/

sorry there is no asr resource available.vox prompt play audio|builtin:default audio/
goodbye.vox prompt end done event handler exit:error.noresource.asr
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Debug Call Failed

If the error that is shown in following appears, one of following scenarios might be occurring:

* The GVP MCP/Resource Manager (RM) is stopped.
* The wrong IP address and/or port is specified for the MCP/RM.
¢ Debugging is not enabled on the MCP.

B2 Problem Dccurred _ [}

Reason:

Transaction from "Debugger” <sip:debugger@10, 10,30, 235;50600> to
"dialag"

<sip:dialog@10. 10.30.80:5070; voicexml=http: /10, 10,30, 235: 30580, Test0S0
42008%2Fsrc-gene2FMain. vwxml; gvp.debug=true = timed out

@ Launching Main.wxml {Time of error: May 4, 2008 3:17:14 PM PDT)

QK Dekails ==

The error that is shown in the next figure indicates an incorrect port. For example, instead of a
request being sent to the MCP/RM, it is being sent to the SIP Server.

B Problem Occurred [_ ]

Launching Main.wxml (Time of error; May 4, 2005 3:40:59 PM PDT)
Reason:
IMYITE ko media platfarm Failed with response 404 Mok Faund

(4 Details ==

The error that is shown in the next figure indicates an incorrect IP address and/or port number of the
SIP phone.
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Problem Occurred M=

Reason:
Transackion from "Debugger” <sip:debuggen@10, 10,30, 23550600 ko
"geeta" <sipigesta@10,10,:30,80:5060= timed out

Q Launching Main,wxml (Time of error: May 4, 2005 3:29:14 PM PDT)

Details ==

The error that is shown in the next figure, along with traces that look similar to those shown in the
example, indicates that you should check the Tomcat configuration on your desktop:

1. Make sure that the Tomcat preferences in Composer are configured correctly: Tomcat port number and
administrator user/password.
2. Make sure that the CV801Tomcat Tomcat service is running.

3. If you are using some other server for a handcoded application, verify that the web application URL is
valid and that the server is running.

4. Make sure the SquidNT service is up and running in the GVP installed machine.

Problem Occurred =]

Launching Main.swxml {Time of error: May 4, 2008 3:31:58 PM PDT)
Reason:
IMYITE to media plakform Failed with response 500 Server Internal Error

Ik Details ==

Example:

appl begin INIT URL=http://10.10.30.235:8001/Test05042008/src-gen/
Main.vxml%7CDEFAULTS=file://C:\ Program Files\GCTI\gvp\VP Media Control Platform 8.0\
MCP dev-vm-geeta 8.0.004.01\config\defaults-ng.vxml|ANI=|DNIS=|PROTOCOLNAME=unde
fined |PROTOCOLVERSION=undefined|CALLIDREF=08441b4de6dda90f05c220cfcd3d85d1@10.10.30.
235|VXMLI TYPE=NGI wf lookup http://10.10.30.235:8001/Test05042008/src-gen/Main.vxml
fetch start document:http://10.10.30.235:8001/Test05042008/src-gen/Main.vxml

wf lookup file://C:/Program Files/GCTI/gvp/VP Media Control Platform 8.0/MCP_dev-vm-
geeta 8.0.004.01/config/defaults-ng.vxml fetch start document:file://C:/Program
Files/GCTI/gvp/VP Media Control Platform 8.0/MCP_dev-vm-geeta 8.0.004.01/config/
defaults-ng.vxml fetch end Fail (HTTP error response 503):http://10.10.30.235:8001/
Test05042008/src-gen/Main.vxml wf arrived s (memory):file://C:/Program Files/GCTI/
gvp/VP Media Control Platform 8.0/MCP_dev-vm-geeta 8.0.004.01/config/defaults-ng.vxml
appl_end
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Stale Application Pages

The following example indicates that stale application pages are being picked. During the
development mode, change the settings as shown:

1. For dynamic applications with jsp/aspx pages, set the expires immediately so that the latest copy of the
pages is picked.

2. In production, upon redeploying the application, flush the Squid cache.

3. In the VoiceXML properties explicitly, set documentmaxage=1s.
Example:

appl begin INIT URL=http://10.10.30.235:8080/Test05042008/src-gen/
Main.vxml%7CDEFAULTS=file://C:\ Program Files\GCTI\gvp\VP Media Control Platform 8.0\
MCP_dev-vm-geeta 8.0.004.01\config\defaults-ng.vxml|ANI=|DNIS=|PROTOCOLNAME=unde
fined | PROTOCOLVERSION=undefined | CALLIDREF=bc668983caef34cc5e4707d52c730b23@10.10.30.
235|VXMLI TYPE=NGI wf lookup http://10.10.30.235:8080/Test05042008/src-gen/Main.vxml
fetch start document:http://10.10.30.235:8080/Test05042008/src-gen/Main.vxml

wf lookup file://C:/Program Files/GCTI/gvp/VP Media Control Platform 8.0/MCP_dev-vm-
geeta 8.0.004.01/config/defaults-ng.vxml fetch start document:file://C:/Program
Files/GCTI/gvp/VP Media Control Platform 8.0/MCP dev-vm-geeta 8.0.004.01/config/
defaults-ng.vxml wf arrived s (memory):http://10.10.30.235:8080/Test05042008/src-gen/
Main.vxml
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CTIC Application Errors

The following example uses a CTIC operation, which throws an error event to indicate that the
operation is not supported in the case of CTI using SIP Server.

Example:

eval cond:{AppState.g CTICCall == 'false'}=true event
error.com.genesyslab.composer.unsupported:1|AccessNumGet is not supported in case of
CTI using SIPServer event handler _enter:error.|http://10.10.10.97:8080/
JavaVoiceProj CTIC/src-gen/AccessNum GetApp.vxml log
com.genesyslab.quality.failure:error event terminated session

Scenarios:

e Through InteractionData, you want to perform a userdata delete in CTIl using SIPS scenario.

e Through InteractionData, you want to perform a userdata deleteAll in CTI using SIPS scenario.
e Through InteractionData, you want to perform a userdata replace in CTl using SIPS scenario.

* You want to perform a Statistics PeekStatReq or GetStatReq in the CTI using SIPS scenario.

* You want to perform an AccessNumGet in the CTI using SIPS scenario.

¢ Through RouteRequest, you set a transfer type to consultation in the case of CTl using SIPS scenario.

A receive error event is thrown to indicate when a <receive> operation fails and an error is reported
by CTIC.

<genesys:receive maxtime="10s"/> <if cond="isCTICResult(application.lastmessage$) ==
'false'"> <throw event="error.com.genesyslab.composer.receiveerror" messageexpr="'The
received message has invalid content-type.'" /> </if>

An operation timeout error event is thrown to indicate when a <receive> operation, which is
executed in the context of a CTIC specific operation, times out.

<if cond="AccessNumGetlResultReason == 'Timeout'"> <throw
event="error.com.genesyslab.studio.operationtimeout™
messageexpr="AccessNumGet1lResultReason" />
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How to View SNMP MIBs

This topic describes how to view the SNMP MIBs by using a MIB browser. Genesys Voice Platform
(GVP) components maintain status information and statistics in SNMP MIB tables. You can view and
query these MIBs with an SNMP Management Console.

For a list of the GVP SNMP traps and SNMP MIB tables, see the Genesys Voice Platform 8.1 SNMP and
MIB Reference.

GVP Policy Server does not support SNMP MIBs or traps.

Viewing the MIBs

This section describes how to enable SNMP MIB browsing.

Prerequisites

* You must have already installed and configured the Genesys SNMP Master Agent. See the
Framework 8.1 Deployment Guide. * You must have already installed the GVP installation package VP
MIB. See the Genesys Voice Platform 8.1 Deployment Guide.

Requesting Values

1. Install any MIB browser.

2. Import the GVP MIBs from the MIB installation directory, and have them compiled in the MIB browser
that you have installed.

The GVP MIB component has two files: GVP.mib and GVP-TRAPS.mib. It is important that you
compile the mibs in the following order:

a. Compile GVP.mib first.

b. When you are done compiling GVP.mib, compile GVP-TRAPS.mib. The GVP-TRAPS.mib has
dependencies from the GVP.mib file and will create compilation errors if you compile it first.

You cannot query and extract MIB data from any of the agents in which GVP is running unless GVP MIBs
are compiled and imported into the MIB browser.

3. Configure the browser to connect to the Master Agent’s ip:port.
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4. Load the MIB from the VP MIB IP: Expand the tree, and select a leaf node—for example, GVP-MIB >
gvpApps > mcp > mcpScalarTable >mcpScalarEntry-mcpStartTime.

5. Issue a GETNEXT. When correctly set up, the Master Agent will return a name/value/type—for example,
mcpStartTime.<MFDBID>, <some date+time>, OCTET STRING.

6. To use GET, you will need to know the index variables (such as the MF DBID for scalar values) and
append it to a node’s OID. For example, select mcpStartTime and you will get 0ID
.1.3.6.1.4.1.1729.200.145.1.1.2.

To issue a GET with MFDBID=100, add .100, such that the OID is
.1.3.6.1.4.1.1729.200.145.1.1.2.100.

For a non-scalar table, you must append more values after the MFDBID.
Debugging

1. If you get a timeout, verify that the Master Agent is running and the ip:port of the MIB browser is the
same as the ip:port of the ServerInfo in the Master Agent’s Management Framework
configuration.

2. If you receive a random value for GETNEXT, verify that the component being queried is running and has
a connection to the Master Agent in the component’s Management Framework configuration.

You can also check if there is a port conflict by stopping the Master Agent and running it directly from
Window’s Start menu. The console will display that the ports were opened for listening.
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Troubleshooting Tools

This topic provides information about third-party tools that might be useful in assisting you with
troubleshooting Genesys Voice Platform issues.

Wireshark

Windows

Wireshark is a network protocol analyzer that captures packets from a number of different devices.
Although Wireshark supports over 700 protocols, for call flow analysis only, SIP and RTP are typically
investigated. Wireshark is freeware and you can obtain it from the Wireshark website at
www.wireshark.org. See “Collecting Packet Traces” for more information.

Linux

To collect network capture, log in as root user, and enter the following command:

tcpdump -s 0 > filename.cap

See man tcpdump for more information.

System Tools

Windows

The two Windows built-in tools available to monitor the system performance are PerfMon and Task
Manager. You can use these tools for GVP troubleshooting by monitoring CPU usage, memory usage,
and network traffic. See “Collecting Data” on page 19 for more information.

Linux

Two Linux tools are available to monitor system performance. To see process related system
information, you can use the top command. To see system level information, you can use the sar
system tool to investigate system information.

By default, Linux systems typically store seven days of system data taken in
10-minute intervals in the /var/log/sa/ directory. The Linux System Administrator
can modify the default or add their own system monitor settings.
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Improving Conference Performance

Large conferences can achieve higher performance by disabling Conference Gain Control. But
Genesys does not recommend doing so in the default configuration Conference Gain Control.

To enable Conference Gain Control, use the MCP option [conference] gain control enabled.

gain_control_enabled Optional Valid values: true, false Default: true Takes effect at: start or
restart.

Set to true to enable conference gain control; various configurations used to set gain levels will be
respected fully. Set to false to disable gain control; streams are muted for gains of 0. Streams are
unaffected for gains greater than 0.

Nuance

You can test the SpeechWorks Media Server install by using the included mrcpClient, and you can
test the Nuance Speech Server install by using the included client. Install the client on a Windows
server and run the sample application from the command line. This generates an MRCP log output
file, which you can compare to the log in the appendix of the Nuance installation manual. See the
Nuance documentation for additional information about the clients.

Licenses

When Nuance Speech Servers are overloaded and are running out of licenses, they return the
message 500 Server Internal Error for any subsequent requests from MRCP Proxy or MCP—and
the request fails.

Workaround: Provision your Nuance licenses based on the expected capacity of the
deployment—the number of peak concurrent GVP ports that use ASR and TTS—so that the Nuance
Speech Servers do not run out of concurrent licenses.

Softphone

Approximately 50 different softphones are available on the internet. You must have a sound card,
microphone, and speakers to use in conjunction with a softphone. You can use a softphone to
generate calls to the GVP IP environment to ensure correct call flow.

A commonly used variation is X-Lite, which is available from Counter Path, at www.counterpath.com.
Another variation is SJphone, which is available from S] Labs website; www.sjlabs.com. Sjphone
supports SIP and H.323 messaging.

The Kapanga Softphone variation is also used. It enables users to make phone and video calls, and
send and receive faxes using any Voice over IP (VolIP) telephone provider. It is available from the
vendor website at www.kapanga.net.
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Curl

Curl is a command line tool for transferring files with URL syntax. It supports FTP, FTPS, HTTP, HTTPS,
GOPHER, and TELNET. It is useful for checking HTTP cache headers. Curl is available by default on the
RedHat Linux system, or you can find this tool on the Curl website; http://curl.haxx.se/.

Example for returning only the HTTP Header: C:\ Curl -I http://localhost/SampleApp/
TestGrammar.grxml

The -1 is an upper case letter i.
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Frequently Asked Questions

This topic describes common issues with Genesys Voice Platform (GVP) components, and how to
resolve them. It contains the following sections:

* Media Control Platform

¢ Reporting Server

¢ Resource Manager

¢ Cluster Mode Connection Failure

e T-Server-CUCM to Media Server Connector

* Troubleshooting Fetch Issues
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Frequently Asked Questions Media Control Platform

Media Control Platform

This section describes issues with the Media Control Platform (MCP).

RTP Not Played: Announcement Application on Linux

Problem

On Linux, a call flow in which an announcement is played prior to being transferred to an agent, does
not play the announcement and the RTP stream does not show up in a Wireshark test.

Resolution

This issue might be due to an incorrect configuration in the /etc/hosts file, which can cause the MCP
to send an incorrect IP address in the Session Description Protocol (SDP). Some SIP phones filter RTP
packets, based on the source IP address. There are two parts to this resolution:

1. Avoid this issue by ensuring that the first line of the original /etc/hosts file is not changed.
For example, you will see the following instructions in the file:

# Do not remove the following line, or various programs

# that require network functionality will fail.

127.0.0.1 localhost.localdomain localhost

This means that the line that begins with 127.0.0.1 must not be changed.

2. Itis possible that the MCP server cannot resolve the hostname of other servers in the network. In this
case, there are a few options:

e If DNS is used, ensure that the MCP server is configured to use the correct DNS server, and that it
can resolve the hostname correctly (recommended).

e Configure the other network components to use the IP address instead of the hostname.

* Edit the /etc/hosts file for Linux, at C:\WINDOWS\system32\drivers\etc for Linux to specify the
mapping between the hostname and IP address.

For Linux, you must still ensure that the first line in the /etc/hosts file is not modified.

Network Connection Problem: SocketError

Problem

When the Media Control Platform is under load, some calls are terminated due to an error when the
network connection is created. The Media Control Platform log contains error messages that refer to

SocketError.
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Resolution

If this problem is found on Windows, ensure that you change the registry settings, as described in the
section “Modify Windows Registry Settings”, see Chapter 5 in the Genesys Voice Platform 8.1
Deployment Guide.

On Windows, after a TCP connection is closed, the operating system does not release the TCP port for
240 seconds. The registry change reduces the timeout to 30 seconds to release the TCP ports sooner
for new calls.

If the problem is not resolved after the registry change, increase the port range that is allocated for

the connection that runs out of ports. The following port range configuration options are available for
the Media Control Platform.

e [stack]connection.portrange

e [vrm]rtp.portrange

e [vrm]client.mrcpv2.portrange

e [mpclrtp.portrange

e [mpclrtsp.connection.portrange

e [mpclrtsp.rtp.portrange

Conference Video Mixing Does Not Work

Problem

When attempting conference video mixing, the calls end immediately upon joining the conference or
the video is not mixed.

Resolution

Confirm that the video transcoders corresponding to the conference participant video codecs are
enabled (H.263 and/or H.264) in the [mpc] transcoders configuration.

Video Text Overlay does Not Work

Problem

Video text overlay does not work, either by not displaying any text overlayed on the video, or by
throwing an error in the application.

Resolution

Confirm that the video transcoders corresponding to the video file being played and the video codec
negotiated are enabled (H.263 and/or H.264) in the [mpc] transcoders configuration.

If this does not resolve the issue, check that the font file you want to use is located in the directory
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specified by [mpc] font paths linux (for Linux) or [mpc] font paths win (for Windows).

Calls Are Not Being Accepted

Problem
SIP calls are not being accepted, and the 100 Trying message is not being sent.
Resolution

Confirm that the firewall for your machine allows traffic on all SIP related and media related ports.

Media Files Are Slow to Start Playing

Problem
Media files (in particular large ones) are slow to start playing.
Resolution

If the files are large (as can be the case with video files), it is possible that the files are being fetched
multiple times, and are not being cached. Try increasing the values on [fm] cachemaxsize and [fm]
cachemaxentrysize, with [fm]cachemaxentrysize being larger than the file being played, and

[fm] cachemaxsize being increased in similar magnitude to the increase done for [fm]
cachemaxentrysize.

If this change does not resolve the issue, try separating the video file into smaller size files.

CPU Usage Higher than Expected When Using Video

Problem

MCP CPU usage is higher than expected when video calls occur, while all participants are using the
same video codec.

Solution

If all users are using the same video codec and the same profiles and levels when relevant, disabling
the video transcoders can improve performance, since the MCP may be performing bitrate or
framerate adjustments as is requested by the negotiated codecs. Even though this adjustment is
desired based on the negotiation, it does require additional CPU resources to perform, and may not
be explicitly required by the clients. Removing the transcoders can be done by removing H263, H264
and VP8 from [mpc] transcoders and restarting the MCP, or, adding
gvp.config.mpc.disabledtranscoders=H264 H263 VP8 to the relevant IVR Profile.
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This will disable text overlay, mixed video conferencing capabilities, track cache
abilities for the video, and video transcoding between codecs and different profiles
and levels will not work.
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Reporting Server

This section describes issues with the Reporting Server (RS).

e Internet Explorer error: Web page cannot be found
* Only loopback connection is supported

GVP dashboard

* Troubleshooting options

Internet Explorer error: Web page cannot be found

Problem

The RS returns HTTP errors in numerous situations, such as when the report URLs or parameters are
malformed, or when data is not available to fulfill a given report request. In such cases, the HTTP
response has error code 400, and contains a human-readable error message.

By default, in Internet Explorer (IE), an HTTP response with error code 400; however, results in |IE
displaying a page with the text Web Page Cannot Be Found. As a result, the error message returned
by the RS is not displayed.

Resolution

1. In IE, go to the Tools > Internet Options > Advanced tab.
2. Clear the Show Friendly HTTP Error Messages option.
3. Click OK.

Only loopback connection is supported

Problem

The RS can connect to an LCA only on the local host, and it relies on the DNS resolution of the host
name localhost for this. If the local host file has been modified so that local host is resolved to
anything other than 127.0.0.1, the RS will not be able to start up and would generate an error
message like this:

17:19:59.082 gvp-linux-ngi RS 252 ERROR LCAManager
-com.genesyslab.platform.commons.protocol.ProtocolException: Only loopback (localhost
or::1) connection is supported
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Resolution

On a Linux platform, open the /etc/hosts file and make sure the line 127.0.0.1 localhost is in the
file.

On a Windows Server 2003 platform, open the c:\windows\system32\drivers\etc\hosts file and make
sure the line 127.0.0.1 localhost is in the file.

GVP dashboard

In the IVR Profile Utilization report, the value for In-Progress Sessions is current as of the CDRs in
the Reporting Server’s database. If this value does not appear to be accurate, generate a
corresponding CDR report to validate that CDRs are available for calls.

Troubleshooting options

Sometimes in some specific cases, engineering might request some "hidden" options adjustments to
troubleshoot and/or fine tune a customer's environment. Those options are not described in the
options reference guide due to a safeguard measure. A few of them are described here, for an
informational purpose.

Warning

Never change these options unless specifically instructed by Genesys Customer Care
or Genesys Engineering.

Version: 8.5.130.61
Section: persistence

hibernate.connection.isolation
Default Value: 2

Valid Values: 1, 2, 4, 8

Changes Take Effect: at start/restart

This parameter can be used to configure the JDBC transaction isolation level for MS SQL Server. Valid
integer values are 1 (READ UNCOMMITTED), 2 (READ COMMITTED), 4 (REPEATABLE READ), and 8
(SERIALIZABLE).

hibernate.remote.database
Default Value:

Valid Values: Database Name
Changes Take Effect: at start/restart
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The name of remote database that will be used for RS. Used to help construct the JDBC connection
URL.

A minor change is required when Reporting Server is deployed with an Oracle RAC database. When
the hibernate.remote.database configuration option is used, the Reporting Server internally appends
some parameters to the value of the hibernate.remote.url option, including the value of the
hibernate.remote.database option. Therefore, ensure the hibernate.remote.url option is properly
configured for use with Oracle RAC by configuring the hibernate.remote.database option with the
value blank.

To support SCAN addresses used in Oracle, set these Reporting Server options:
[persistence] hibernate.remote.database <make it empty>

[persistence] hibernate.remote.url = jdbc:oracle:thin:@<SCAN address>:<port>/<service
name>

The first of these means to set the hibernate.remote.data option to blank, [mentioned
already in the config file] where as for the second option you should replace the
<SCAN address> with the FQDN of the scan address you've set up for Oracle RAC, <port>
is the port number to access Oracle, and <service name> is the name of the Oracle
service that has been set up to be used by the Reporting Server.

For example: jdbc:oracle:thin:@dbgenesys-scan.pdc.hcnet.vn:1521/gvreport.pdc.hcnet.vn
[Not related to your configuration]

Then try to start Reporting Server.

hibernate.remote.dialect

Default Value:

Valid Values: org.hibernate.dialect.SQLServerDialect,
org.hibernate.dialect.Oraclel@gDialect

Changes Take Effect: at start/restart

The dialect Hibernate should use when interacting with the database.

hibernate.remote.driver

Default Value:

Valid Values: com.microsoft.sqlserver.jdbc.SQLServerDriver,
oracle.jdbc.driver.QOracleDriver

Changes Take Effect: at start/restart

SQL Driver Hibernate should use when interacting with the database.

hibernate.remote.url

Default Value:

Valid Values: JDBC URL

Changes Take Effect: at start/restart

The JDBC URL that RS should use to connect with the database. For Oracle, the final URL is
constructed by appending a colon plus the hibernate.remote.database string to this option's value.

For SQL Server, the final URL is constructed by appending ';databasename=' plus the
hibernate.remote.database string to this option's value. The JDBC connection URL will equal the
hibernate.remote.url string if the hibernate.remote.database parameter is set to empty.
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See also hibernate.remote.database.

hibernate.remote.user

Default Value:

Valid Values: User Name

Changes Take Effect: at start/restart

The user name that RS should use to connect the the remote database.

hibernate.show_sql

Default Value: false

Valid Values: false, true

Changes Take Effect: at start/restart

Enables output of the SQL statement generated by Hibernate to the console.

password

Default Value:

Valid Values: User Password
Changes Take Effect: at start/restart

The password that RS should use to connect the the remote database.

rs.histonly.enabled

Default Value: false

Valid Values: false, true

Changes Take Effect: at start/restart

Configures the RS to run in HIST-Only Mode. The RS will never write to the remote database, but will
continue to support historical report queries. The HIST-Only RS does not support writing CDR, OR,
SQA, or log data. It does not support data summarization or data purging. It does not support
realtime (RT) call reports.

rs.nodb.enabled

Default Value: false

Valid Values: false, true

Changes Take Effect: at start/restart

Enables the 'no DB' feature for running the RS without a remote DB. This option controls 'no DB'
mode. In 'no DB' mode, the RS functions without a remote DB, however, only a limited number of
reporting services are available.

rs.partitioning.enabled
Default Value: false

Valid Values: false, true
Changes Take Effect: at setup

Enables CDR/VAR/Upstream partitioning feature. This option must not be changed after initial RS
installation (unless the database is reconfigured).

rs.partitioning.partitions-per-day
Default Value: 8

Valid Values: 1, 2, 3, 4, 6, 8, 12, 24
Changes Take Effect: at start/restart
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Number of partitions a day for CDR/VAR/CustomVAR/EVENT storage. It must be a divider of 24. The
higher values are suitable for smaller partitions and high capacity storage. Smaller values correspond
to larger partitions and lower storage capacity.

rs.partitioning.upstream-partition-number
Default Value: 1

Valid Values: 1, 5, 10, 50 and 100

Changes Take Effect: at start/restart

Number of Event Log partitions per a single CDR partition. Higher number intended for larger number
of event metrics per call. At the same time higher number would result in heavier DB activity
associated with storing and querying metric results. The number can be 1 (default), 5, 10, 50 and 100.

rs.partitioning.upstream-start-time.enabled
Default Value: true

Valid Values: false, true

Changes Take Effect: at setup

Enables faster VAR CDR/CDR EVENT queries by using START _TIME query hint.

rs.storage.metricsfilter

Default Value: *

Valid Values: ...

Changes Take Effect: at start/restart

This option controls the metrics that should be persisted to the database backend.

RS uses the string provided to filter metrics before saving to the database. The string uses the same
format as in Reporting Client, such as 0-16,18,25,35,36,41,52-55,74,128,136-141. The default value
is "*". When the parameter is missing, the default value will be assumed and all metrics received will
be saved to the database.

rs.storage.upstream-serializer.watermark
Default Value: 60000

Valid Values: ...

Changes Take Effect: at start/restart

Defines the maximal number of calls cached in the serializer component before new calls are no
longer processed.
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Resource Manager

This section describes specific issues with the Resource Manager (RM) that might require
troubleshooting.

Failover Does Not Work

Problem
The Resource Manager is configured for failover but it is not working.

Resolution

From the command line, issue the $InstallationRoot$/bin/NLB.bat<enable|disable> <cluster
node ID>command to see if the traffic can be redirected manually.

 If traffic can be redirected manually, it is an RM issue. Check the configuration options in the RM cluster
section to ensure that the IP address and port numbers that are specified for each cluster member (1
and 2) are reachable from the other RM host (1 is reachable by 2 and vice-versa).
Specifically check the following configurations:

1. Ensure that the TCP port that is configured in the cluster section for cluster members 1 and 2 is
open and is in a listening state. Verify this by running the netstat command.

2. Ensure that the you can ping the IP addresses that are specified in the cluster section for cluster
members land 2 from each of the RM hosts.

3. If the RMs are installed on Windows, ensure that the IP addresses that are specified in the cluster
section for cluster members 1 and 2 do not belong to the NLB-dedicated NIC (where the virtual-IP is

defined).

4. Ensure that the firewall, if enabled, is not blocking the communication between the RMs in the
cluster.

5. Ensure that all cables are properly connected.

e |If traffic cannot be redirected manually, the issue is outside of the RM and you must check the entire HA
configuration.

Both RMs Are Active, When in Active/Standby Mode

Problem

The Resource Manager (RM) is deployed in active/standby High Availability (HA) mode and both RMs
are active.

Resolution
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This is an indication that the RM nodes cannot communicate properly with each other. See Steps a to
e in “Failover Does Not Work".

Neither RM is Active, When in Active/Standby Mode

Problem

The Resource Manager (RM) is deployed in active/standby High Availability (HA) mode and neither of
the RMs are active.

Resolution

This is an indication that the RM nodes cannot communicate properly with each other. See Steps a to
e in “Failover Does Not Work”.
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Cluster Mode Connection Fallure

Problem

In cluster mode, a message similar to the following is printed continuously in one of the Resource
Manager (RM) logs:

RMCommTCPBonding.cxx:725 700351472 VGSocketError nSocket=605517456

This message indicates that the cluster connection between the two RMs has problems, and even
after retries there is no further communication between the two RMs on the cluster port (which is
used for exchanging messages).

Resolution

Restart the RM process that is printing the log(s) where you find the repeating message.

SIP Error Codes for Rejected Requests

This section describes specific SIP error codes that are returned by the Resource Manager (RM) when
a request is rejected.

480 SIP Response Code (Event Pool Throttling)

The Media Server (MS) may reject incoming calls when the MS control event pools are running low on
available events, in a behavior termed Event Pool Throttling.

When one of the event pools is above the high threshold configurable percentage of used events, it
becomes a “saturated pool.” (Each control event pool's size is configurable.) When there is at least
one saturated pool, the MS starts rejecting calls, using SIP response code 480.

When a saturated pool has dropped below a low threshold configurable percentage of used events, it
is no longer a saturated pool. When there are no saturated pools, calls are accepted again.

503 Service Unavailable

This error occurs when the RM suspends the acceptance of new RM sessions before it gracefully shuts
down. Requests for new RM session creation are rejected with this error code.

500 Server Internal Error

This error occurs if the RM tries to forward a message to a resource that does not have the TCP port
open. The RM tries to use the TCP transport if the forwarded request exceeds the MTU size
(estimation) or if the set route in the ROUTE header of the SIP message, or the Request-URI in the
body of the message, dictates that it to go through TCP (transport=TCP).
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Resolution

Three options exist to resolve this issue:

1. Enable TCP on the resource side.

2. Increase the MTU size by configuring the proxy.sip.mtusize configuration option to a value greater
than the default value of 1500.

3. Disable TCP on the RM.

The first resolution is recommended. The third resolution is would be considered a last resort solution,
since both the proxy should have TCP and UDP ports available.

485 Ambiguous

This error occurs if the RM session ID is specified in a request, and the RM does not recognize it. The
RM tries to create the session, but if the RM session creation fails, the 485 response code is returned.

482 Loop Detected

This error occurs if the RM detects a request that will be forwarded to itself.

481 Call/Transaction Does Not Exist

This error occurs if the RM receives a CANCEL request that does not match any existing INVITE
transactions.

Resolution

1. Check the route that is set, and ensure that the next hop is not the RM itself.

2. Check the configured resources to ensure that the Address of Record (AOR) does not point to RM itself.
If the User Agent Client (UAC)-to-UAC communication is SIPp when the error occurs in the call
scenario, it generates a SIP BYE message with the RM's address in the Request-URI (instead of the

address of the User Agent Server [UAS]). The RM receives the BYE message, determines that it points
to itself, and rejects it with the 481 error. To workaround this issue, use SIPp with the -nd option.

480 Temporarily Unavailable
This error occurs in either one of two scenarios:
1. If all resources are down or unavailable.

2. If the port count, usage limit, or another limit is reached.

408 Request Timeout

This error occurs if the UAS does not respond within the timer-B or timer-F interval.
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405 Method Not Allowed

This error occurs in either one of two scenarios:

1. If an out-of-dialog method, other than a SIP INVITE or OPTIONS message is sent to the RM.

2. If the SIP OPTIONS message contains a user-info parameter and does not have a Max-Forwards
header configured with a value of 0.

404 Not Found

This error occurs in either one of three scenarios:

1. The Logical Resource Group (LRG) that is servicing the requested service type cannot be found.

2. A default IVR Profile is not specified and a matching IVR Profile, based on the DNIS cannot be found.and
no default.

3. Aresource cannot be allocated for a request is to be forwarded to a specific gateway or CTI Connector.

403 Forbidden

This error (which is the default) occurs when either the allow or disallow policy parameter for a
Tenant or IVR Profile is enforced.

400 Bad Request

This error occurs when the request contains values that are not acceptable to the RM. For example:

 If the conference ID is missing in the sip:conf=@<host>:<port> request

e If the Min-SE header in the SIP message has a refresher value other than uac or uas.
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T-Server-CUCM to Media Server Connector

This section describes specific issues with the T-Server-CUCM to Media Server Connector that might
require troubleshooting.

Call Related Errors

Rejecting or Aborting Calls

For rejected or aborted call errors, check the SNMP MIB table, UCMCSummaryTable. The contents of the
UCMCSummaryTable are printed in the log file at regular intervals. You can also check the SNMP
Statistics Summary.

4xx, 5xx, or 6xx Error Responses

The 4xx, 5xx, or 6xx error responses from SIP Server and Resource Manager will be logged in the
UCM-C logs. The calls on SIP/MSML and CP4SM side can be related using the Call LegID received in
the CP4SM message.

Tracing Calls and Media Operations

For tracing calls and media operations, separate ULIDs have been declared that can be leveraged
during load tests for troubleshooting call related issues.
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Troubleshooting Fetch Issues

1. Ensure that the resource can be fetched from a web browser on the same machine as the platform. If
that fails, troubleshoot the web server.
On Linux, you can do this by invoking the following command:

wget fAoutput-document=<output file> <Resource URL>

Where <output file> is the location of the file the fetched content will be written to, and
<Resource URL> is the URL that you are trying to fetch.

2. Try the fetch again using the web browser and ensure that it is configured to use the Squid HTTP proxy
(127.0.0.1:3128), and check the Squid access logs for errors. If that fails, ensure that the Squid
service is running.

On Linux, you can do this by invoking the following command:

curl --output <output file> --proxy 127.0.0.1:3128 <Resource URL>

On Linux, you can use either the wget command or the curl command for fetching.
The preceding steps show each method. Step 2 applies only when troubleshooting NGI
and MCP (does not apply to GVPi).

GVP Troubleshooting Guide 60



	GVP Troubleshooting Guide
	Table of Contents
	GVP Troubleshooting Guide
	Troubleshooting methodology
	Basic Troubleshooting
	Collecting Log Files
	Exporting Configuration Options
	Collecting Logs
	Collecting Data
	Checking Disk Space
	Collecting Dump Files
	Locating Installation Package Versions
	Collecting Packet Traces
	Running test VoiceXML and debugging VoiceXML applications
	Debugging CTI Connector and ICM Client
	Debugging T-Server-CUCM to Media Server Connector
	Debugging Dialogic

	Troubleshooting with Composer
	HTTP 503 Error
	No TTS Resource
	No ASR Resource
	Debug Call Failed
	Stale Application Pages
	CTIC Application Errors

	How to View SNMP MIBs
	Troubleshooting Tools
	Frequently Asked Questions
	Media Control Platform
	Reporting Server
	Resource Manager
	Cluster Mode Connection Failure
	T-Server-CUCM to Media Server Connector
	Troubleshooting Fetch Issues


